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What's New in R:BASE 11 (Version 11.0)

Official Release Version

Thursday, June 11, 2026

UPDATE 3

Build: 11.0.3.20611

Requested Enhancements 09/06/2025 - 06/11/2026

Date ImplementedItem Description

11.0.3.20611Release Build:
 

01. 06/04/2026 R:BASE Editor - For the sake of consistency in syntax, allow INMEMORY to be abbreviated as INMEM, such
as TEMPORARY is abbreviated as TEMP.

02. 05/29/2026 Functions - A new JOINPATH function has been implemented to construct a proper system path
regardless of trailing/leading slashes in the path subcomponents.

    (JOINPATH(root,subirectory))

03. 05/28/2026 Data Designer - When creating a new index, it would be beneficial to have a default name populated with
the table name and column name.

04. 05/19/2026 Functions - A new IQTR function has been implemented to return the fiscal quarter number (1,2,3,4) for a
date, based upon a provided fiscal year beginning date.

   (IQTR(date,fydate))

    date - date whose quarter you wish to discover
    fydate - first day of fiscal year

05. 05/18/2026 Functions - A new REVLIST function has been implemented to reverse the order of items in a list of
values. The delimiter argument allows for a custom delimiter in the list. The returned value is list in the
reverse order.

    (REVLIST(text,delimiter))

06. 05/12/2026 ODBC - When making multiple ODBC connections, the set of variables defined for each connection are
now passed with the queries, allowing variable values to be recognized between ODBC connections.
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11.0.3.20414Release Build:
 

07. 04/07/2026 Data Designer - The Keys/Indexes display has been enhanced with an added Column(s) list, providing a
comma separated string, allowing for easier recognition of existing indexed columns.

08. 04/02/2026 Data Browser - An option has been added to the Data Browser settings to show/hide the database name
and path in the Data Browser title bar.

09. 03/31/2026 Commands - Column-level PROPERTY commands have been implemented to load a BLOB field from a file
and save BLOB data to a file.

    PROPERTY TABLE_COLUMN [TableName->ColumnName] LOADFROMFILE 'VarName'

    PROPERTY TABLE_COLUMN [TableName->ColumnName] SAVETOFILE 'VarName'

10. 03/11/2026 Data Browser - Extended column information (key, index, AUTONUM, Not NULL, etc.) is now displayed in
the Data Browser status bar when the column is focused.

11. 03/09/2026 Forms - An Indicator Width property has been implemented for the Enhanced DB Grid control, where the
pointer column, which appears in the first column of the grid to indicate which row is currently selected,
may have its width increased/decreased.

12. 03/03/2026 Stored Procedures - Please make the default dialog larger to improve the visibility of the arguments, and
also allow the window to be increased in size.

11.0.3.20226Release Build:
 

13. 02/12/2026 Database Explorer - The loading of command files for directories with many files has been improved.

14. 01/26/2026 Commands - The LOAD command has been enhanced to specify the starting row of the source file.

    LOAD Calendar FROM CalUpdate275.txt AFTER 10 ROWS 

15. 01/26/2026 Commands - The LOAD ... AS CSV command has been enhanced to allow for specifying a column list in
the target table.

    LOAD Employee FROM EmpCityState.csv AS CSV USING EmpCity, EmpState

16. 01/19/2026 Reports - The Advanced Rich Text report/label control has been enhanced to recognize rich text format
data for VARBIT data type content.

17. 01/14/2026 Commands - The ON FIRST CONNECT, ON AFTER CONNECT, and ON BEFORE DISCONNECT commands
have been enhanced to support calling a stored procedure for the event. The ON BEFORE DISCONNECT
event has also been enhanced to fire in the event a user is force closed with the RBAdmin plugin.

    ON BEFORE DISCONNECT CALL RunLog() SAVE

18. 12/08/2025 Commands - The in-memory table creation process has been boosted with larger memory allocations as
the in-memory table grows, doubling the memory size as needed. In instances of projecting a 2-million
record table, the in-memory temporary table creation time outperformed the file-based temporary table.

11.0.3.11120Release Build:
 

19. 11/12/2025 Utilities - The Data Dictionary includes a new toggle button to control whether or not the utility uses the
Windows clipboard to pass information between the Data Dictionary and destination control (original
behavior). The new behavior transfers the captured data directly, not via the clipboard.

20. 10/13/2025 Settings - A new RESET setting has been implemented which controls whether or not RESET commands
are added to output from UNLOAD commands. The default is ON. 

    SET RESET ON/OFF

Page 2 of 10

Copyright © 1982-2026 R:BASE Technologies, Inc. All Rights Reserved.



11.0.3.11120Release Build:
 

21. 10/08/2025 Settings - A new QUOTEBLANKS setting has been implemented which controls whether R:BASE will add
quotes to blank strings derived from variables, which occurs when using a dotted/ampersand variable
and the NULL setting is all blanks. The quotes added to the blank string is the current QUOTES character.
The default is ON.

    SET QUOTEBLANKS ON/OFF

22. 10/06/2025 Forms - The Tile Menu control was updated with the added "On Home Click" EEP to execute when focus
is directed to the main page.

23. 09/17/2025 Commands - The in-memory table limit has been increased from 25 to 1000.

24. 09/11/2025 Views - In-memory views has been implemented, where the temporary view is stored in memory, not
temporary files.

    CREATE INMEMORY VIEW CustomerContact +
    (CustID,Company,ContID,ContFName,ContLName,+
    ContPhone,ContEMail,LastContactDate) AS  +
    SELECT T1.CustID,T1.Company,T2.ContID,T2.ContFName,T2.ContLName,+
    T2.ContPhone,T2.ContEMail,T2.LastContactDate +
    FROM Customer T1,Contact T2 +
    WHERE T1.CustID = T2.CustID

25. 09/08/2025 Form Designer - The Tab Order settings has been enhanced to select an object on the form canvas with
[Ctrl+MouseHover] even while the modal Tab Order Settings dialog is displayed. The feature allows for
the selected form object to be highlighted in the Tab Order dialog for easier recognition of the control,
especially on forms with many objects. Note that the feature only works on the list of objects in the lower
child controls list view. If the control being hovered is not in the child controls list view, then the auto-
selection will not take place.
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Reported Bug Fixes 09/06/2025 - 06/11/2026

Date FixedItem Description

11.0.3.20611Release Build:
 

01. 06/08/2026 ODBC - When printing a report with variables based upon a SATTACHed table, errors are returned when
PASSTHROUGH is set ON.

02. 06/04/2026 Database Explorer - When searching Command Files using the "Whole Word" option of the Find in Files
utility, the results incorrectly include values which contain the search criteria containing and underscore
and other characters. As a result, when the command file is opened within the Find in Files utility an error
appears stating the criteria could not be found.

03. 06/04/2026 Database Explorer - When searching Control Properties using the "Whole Word" option the results
incorrectly include values which contain the search criteria containing and underscore and other
characters.

04. 05/28/2026 ODBC - A query to an SATTACHed table will fail if a WHERE clause parameter is enclosed in parenthesis.

05. 05/22/2026 Settings - When PASSTHROUGH is ON and no SQL data sources are defined, a local table query does not
work as expected.

06. 05/21/2026 Database Explorer - When using the Find in Control Properties for a form defined with a Tree View
control, the provided results do not match the control's content.

07. 05/20/2026 Reports/Labels - When printing a report with a Variable Memo object with the text defined to wrap, the
text  does not wrap and runs off of the page.

08. 05/14/2026 Commands - When using a WHERE Clause with the SATTACH command error 118 is returned reporting
an incorrect number of values for this table.

09. 05/11/2026 ODBC - Invalid output is returned when using multiple routines and switching context between ODBC
connections.

10. 05/08/2026 Settings - When using the PASSTHROUGH setting, the configuration file reading routine is not correctly
setting the PASSTHROUGH flag.

11. 05/04/2026 Forms - The focus color is not displayed for the Advanced Variable Rich Edit and Advanced DB Rich Edit
controls.

12. 05/01/2026 Commands - When a R:BASE session deletes a record in a form scrolling region, the row is not always
deleted. When the delete is initiated on the form a table trigger appends the deleted record for archiving.
Sometimes, a "Resources are not Available" message is displayed. However, if the form is refreshed the
deleted row disappears. Normally, the row is seen to be automatically removed while the form is
displayed with no action by the user. Other times, the resources message appears. The session is run with
a single user connected.

13. 04/24/2026 R:Compiler for R:BASE - When overwriting an existing executable file, the full path is incorrectly truncated.
It is necessary to display the full path for what is being overwritten.

14. 04/20/2026 Forms - When running a form with 3 tabs, newly added fields/buttons on the second tab do not appear
when the form is initially launched and the tab is displayed. Moving to another tab and back causes the
objects to display.

15. 04/16/2026 Reports/Labels - When printing a report with a Rich Text control with MailMerge, the variables are no
longer being placed on their individual lines by recognizing the (CHAR(013)) in the variable value.
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11.0.3.20611Release Build:
 

16. 04/16/2026 Commands - When using the SET VARIABLE command with an ampersand variable as the variable name,
an error is returned.

17. 04/15/2026 Forms - When running a form with a read only variable link defined, the form appears with extra blinking
and the session appears to lock up forcing an end task.

18. 04/15/2026 Data Browser - When displaying the extended field details for columns, please also include if the field has
a default value.

19. 04/14/2026 Commands - When using the TALLY command with a query where names contain embedded blanks with
an aggregate function (e.g. COUNT(*)) and GROUP BY in a SELECT, the results would fail.

11.0.3.20414Release Build:
 

20. 04/10/2026 Forms - When the Table Settings dialog is displayed and the EEP options are expanded, the panel does
not scroll when the mouse wheel is used.

21. 04/08/2026 Forms - When using the DB Memo or Unicode DB Memo controls the BLOB Editor does not open when
the control is double clicked.

22. 04/02/2026 Forms - Using Variable Lookup List View within a multi-tab form may cause a rendering issue for the
column header area.

23. 04/01/2026 Reports/Labels - When printing a report using an expression with an ORDER BY, the initial value is
 incorrectly repeated for the output.

24. 03/24/2026 Commands - When using the LIST COMPUTED command, invalid characters are returned when an
expression value is defined with over 500 characters.

25. 03/24/2026 Commands - When using a DISTINCT DECLARE CURSOR on a temporary table, only the first FETCH
locates the distinct value. The follow-up FETCH command incorrectly returns the same value as the first
FETCH.

26. 03/18/2026 Database Explorer - When using SET CAPTION with MDI set to ON, a table opened in the Database
Explorer appears with no name/value in the tab.

27. 03/16/2026 Commands - When using the CHECK_WEBVIEW2 parameter to check that WebView2 Runtime is installed,
"Not Found" is returned, even though the app has been installed on the computer.

28. 03/11/2026 Data Browser - The column title characters may be truncated by a few pixels when the title value is as
long as the column width.

29. 03/09/2026 Forms - When defined, the color for the Enhanced DB Grid column's Hint Expression is not applied.

30. 03/09/2026 Settings - CHOOSE command parameters passed as a variable loses the options when the FEEDBACK
setting is enabled.

31. 03/06/2026 Form Designer - When working with a form with many database controls, there is a noticeable lag
between selecting DB Edit controls.

32. 03/06/2026 Form Designer - When deleting many database controls from a form, the process is slow as only one
object is removed at a time.

33. 03/06/2026 Form Designer - After selecting many database controls from a form with Ctrl+A, the un-select process is
slow as only one object is un-selected at a time.

34. 03/06/2026 Form Designer - When capturing many database controls in the clipboard from a form using Ctrl+X, the
process is slow as only one object is captured at a time.
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11.0.3.20414Release Build:
 

35. 03/06/2026 Form Designer - The closing behavior when objects are unselected in the designer has been corrected,
where the form will close without unselecting the objects first.

36. 03/05/2026 Commands - Within a DECLARE CURSOR loop the initial FETCH variables are not populated as expected.

37. 03/04/2026 Functions - When using the IFNULL function to query if a VARBIT record has data, the results are always
not NULL.

38. 03/02/2026 Commands - When using LOAD AS CSV with data which contains parenthesis, the LOAD process appears
to interpret the open parenthesis as a delimiter.

39. 02/26/2026 Form Designer - When a DB/Variable Radio Group control is placed over an image background a
noticeable flicker behavior is encountered when the form loads. The flicker behavior also occurs for the
radio group and object handlebars when right-clicking between controls in the Form Designer.

11.0.3.20226Release Build:
 

40. 02/24/2026 File Gateway - When importing a spreadsheet containing tags with namespaces and inline strings the
expected content is not displayed in the File Gateway.

41. 02/17/2026 Form Designer - There is a noticeable form "refresh and reset" flicker behavior for the designer toolbars
when selecting controls.

42. 02/17/2026 Commands - When the structure is unloaded for ON DISCONNECT database events, the DISCONNECT
keyword is truncated to eight characters.

43. 02/16/2026 Database Explorer - When a database RELOAD is performed the new database is not displayed at the
Database Explorer automatically. A refresh is needed.

44. 02/06/2026 Forms - When text is assigned to "blink" the behavior does not occur.

45. 01/20/2026 Forms - When defining a DB Memo on a form the Pop-up Menu option to select an available table does
not list the tables.

46. 01/15/2026 R:BASE Editor - After a stored procedure is checked with R:Style, there is a delay in altering the code
where the editor appears to require a refresh.

47. 01/12/2026 File Gateway - When importing a spreadsheet file where the tab name contains an ampersand, the tab
name incorrectly displays with an underscore in the preview dialog upon the lower grid tab.

48. 01/05/2026 Query Builder - In instances of viewing query data in the Data Browser, temporary scratch files are not
being dropped as expected.

49. 12/26/2025 Commands - When creating a multi-line variable containing concatenated TEXT and INTEGER data for a
PAUSE message, an "Expression size limit exceeded" error may appear.

50. 12/16/2025 Forms - When the originally displaying the Tab Order dialog, the list starts at 1. When the first child item
in the list is selected, the tab order value in the "Tab Order" field is 0. When a tab order is changed to 1,
the field is assigned to tab order 2. The numbered child control  list and the tab order values should start
at the same initial value (0 or 1).

51. 12/09/2025 Forms - When the "Display Format for Non-Text Values" is defined for a DB Label, the formatting is not
applied.

52. 12/08/2025 Commands - When using PROJECT with INMEMORY for a large table it takes several minutes. When using
a TEMP table, the table is created in a few seconds.

53. 12/08/2025 Commands - When running a routine which call another command file with the RUN command, R:BASE
processing stops responding.
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11.0.3.20226Release Build:
 

54. 12/04/2025 Forms - When the Variable Lookup List View is refreshed there is a noticeable flicker when repainting the
content.

55. 12/03/2025 Database Explorer - When searching for text in form Custom EEPs, defined text is not located within
Office Button controls.

56. 12/03/2025 Forms - When adding an Arrow Line control to a form, the caption "RzLine<n>" is incorrectly added to
the middle of the line. Multiple arrow lines increment the captions to RzLine2, RzLine3, etc.

57. 11/25/2025 Forms - When a form is scaled to fit the screen, the individual radio buttons in radio button group
controls are incorrectly sized/truncated.

58. 11/21/2025 Indexing - After repeated data imports an error appears stating that there are problems updating the
index file, which may have been corrupted.

11.0.3.11120Release Build:
 

59. 11/17/2025 Forms - The filtering performance in DB Grid and Enhanced DB Grid controls has decreased in the recent
September 05 update.

60. 11/14/2025 Database Explorer - When an underscore is defined within an object's name (table, form, report, etc.), the
underscore is listed at the end of an alphabetically sorted list. This sort differs to how operating systems
sort the underscore in folders, and also how areas of R:BASE sort objects. For example, in the
Import/Export dialog, the table names with an underscore in the name are listed before letters.

61. 11/14/2025 File Gateway - When the [Alt] is pressed during the number of rows processed import dialog, the import
process incorrectly stops.

62. 11/12/2025 Utilities - When displaying all details (Name, Table Name, Comment, Date/Time) in the Data Dictionary,
include the missing Version column. Also, the Table Name caption should read "Table/View Name" as
both may be assigned.

63. 11/07/2025 Commands - When table structure is unloaded, the comments and rules are written as ANSI while the rest
of the table definition is UTF8, resulting in an incorrect mixed content.

64. 11/05/2025 Reports/Labels - When printing a report to a PDF file from the Print Preview screen, expected data at the
bottom of the first page is not included.

65. 11/04/2025 Forms - When using a DB Tree List control and selecting a node via EEP code, the data change event is
not triggered.

66. 10/31/2025 Forms - When displaying a list view who's dynamic WHERE clause includes an ampersand variable, the list
view content is not populated. The ampersand variable for the WHERE clause can be NULL or contain a
value.

67. 10/28/2025 File Gateway - If a duplicate import is performed, while selecting to clear the existing records on the final
screen, the subsequent import is much slower than the initial import.

68. 10/28/2025 File Gateway - When importing a fixed format text file, not all of the expected rows are loaded into the
table. The file being imported has 52,225 lines of records. However, when the import is completed, there
are only 40,707 rows in the table. The initial "Preparing records ..." status in the "number of rows loaded"
dialog is where the incrementing import value stops at 40,707 rows.

69. 10/28/2025 File Gateway - When reviewing the break line wizard screen for a fixed format import, the file display of
character coordinates resets incorrectly when the mouse button is clicked, held down, and released within
the horizontal scroll bar.

70. 10/28/2025 File Gateway - The "Importing..." dialog with the rows Added/Processed is incorrectly on top of all opened
windows for the operating system. The dialog should be specific to R:BASE.
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11.0.3.11120Release Build:
 

71. 10/27/2025 File Gateway - When loading a specification file for a fixed width format text file, the assigned starting
and ending break lines for the desired data sections are not retained in the break line wizard screen. The
GUI appears with lines, however the locations are incorrect.

72. 10/27/2025 Forms - When using the PROPERTY command to alter the background color of a DB Grid control, the
color is not updated as expected.

73. 10/24/2025 Report/Label Designer - When adding/removing items within a report band, the "Number of Objects: #"
caption on the band is not automatically updated. The band must be physically moved with the mouse, or
the designer must be closed and reopened in order for the "Number of Objects: #" caption to appear as
expected.

74. 10/24/2025 Data Designer - When clicking to save table changes, if you click on the designer background the "Save
Changes" dialog is incorrectly placed behind the R:BASE window. This causes confusion as the Save
confirmation dialog will also be behind the main R:BASE window.

75. 10/24/2025 File Gateway - When importing a XLSX spreadsheet file into a table a "file limit" message appears. The file
does import into the table as expected using version X.5.

76. 10/23/2025 Settings - Steps may be repeated where the configuration file may be wiped out of all settings/content.

77. 10/23/2025 Settings - The Configuration Settings dialog can incorrectly display TMP as the SCRATCH setting when
the setting is not defined as such.

78. 10/22/2025 Report/Label Designer - After a text variable expression is modified with added static text, the variable on
the report does not reflect the change after saving and previewing the report.

79. 10/21/2025 Form Designer - When using the green arrow buttons to move a selected item up or down the list, if a
button is clicked many times and the item moves up/down beyond the visible scope, the arrow button
can keep being pushed, but you do not know where the current item is located in the order. Please
ensure the selected item stays visible when moving up and down the list.

80. 10/21/2025 Report/Label Designer - When static text labels are defined as bold, and then the bold style is removed,
the report preview still displays the text as bold.

81. 10/20/2025 File Gateway - When loading a file for an import and after the R:BASE background is clicked, the import
progress dialog is now behind the R:BASE window. The behavior can be confusing as the user does not
know that the import is still taking place, especially when switching to another program and back to
R:BASE. The import dialog should remain on top of the R:BASE window when running.

82. 10/20/2025 External Form Designer - When selecting "Form > Save Form As" from the menu bar or the "Save Form
As" button, the file name field is blank. Please update the file name field to provide the "existing" external
form file name, to easily define a new file name that is similar to the existing file name, without having to
type out the file name.

83. 10/16/2025 WHERE Builder - The "Add Column" button, or the action of double clicking on a column name in the
"Select Columns" list, incorrectly overwrites the value in the Windows clipboard.

84. 10/16/2025 Form Designer - When using the Form Designer menus and property editors, the clipboard content may
be incorrectly overwritten when using the Data Dictionary to capture information.

85. 10/15/2025 Forms - When using Variable Edit fields with dynamic WHERE clauses, the expected results are not
displayed in pop-up menus.

86. 10/13/2025 Forms - The drag-and-drop functionality for use in list view controls does not behave as expected.

87. 10/09/2025 Report/Label Designer - The "Edit > Code" menu option in the Form Designer provides search options
when the "Code" tab is viewed and no EEP has been opened in the Editor. Even though code may be
searched in reports/labels, the "Edit > Code" menu option is missing.
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11.0.3.11120Release Build:
 

88. 10/08/2025 ODBC - When SATTACHing a table with column names as reserved words when ANSI is set OFF, the table
is attached but cannot be opened in the Data Browser.

89. 10/07/2025 Forms - When a Tile Menu is used to display the Detail control, the title gets updated with the Detail's
caption. But, if the prior title is shorter than the new one, the new title is drawn in the rectangle occupied
by the previous title (which is not as wide).

90. 10/07/2025 File Gateway - When a new table import takes place and R:BASE recognizes that there are data type
differences between the existing columns and the new columns and a new column name is automatically
generated, an 18-character limit is incorrectly assigned to the new column name  length.

91. 10/06/2025 Forms - When launching a form with a Web Browser control using MS Edge as the browser engine on a
new Windows 11 operating system, the Web Browser does not display the content as expected. 

A newer WebView2Loader.dll file is included with product updates and installers.

92. 10/06/2025 Label Designer - When the designer is open and the database is disconnected, the "Close the Report
Designer first" message is displayed.  The message should read "Close the Label Designer first" if that
specific module is open.

93. 10/02/2025 Data Types - The internal handling of VARBIT variables has been corrected.

94. 10/02/2025 Database Explorer - When copying a report, the "Reset Version Number" option is not checked by
default, which differs from when copying a form.

95. 10/02/2025 Report Designer - Reports with many rich text controls may fail to open in the designer.

96. 10/01/2025 Print Preview - When printing a report to the screen which has over 10,000 pages, the page count value is
truncated.

97. 10/01/2025 Form Designer - When using the Tab Order Settings dialog on a form with many controls, the focus upon
objects in the lower list view would automatically change if there were objects "behind" the Tab Order
dialog.

98. 10/01/2025 Form Designer - When tabbing from field to field for DB Edit objects which are located on the form
background layer, the Static Text, Panels, and several of the Form Designer toolbars blink/refresh each
time the [Tab] key is pressed.

99. 09/22/2025 Forms - The DB Tree Grid control does not correctly utilize the R:BASE session's regional settings.

100. 09/22/2025 File Gateway - When multiple specification files (.rgw) reside in the same folder, where the file copies
were made by using a copy/paste of the file in Windows Explorer, the .rgw files incorrectly display in the
File Gateway with the same exact name.

The file list was updated to display the .rgw file name and the specification name.

101. 09/22/2025 Forms - When using dynamic tiles within the Tile Menu control, the tile generation does not correctly
process the carat "^" line break character.

102. 09/22/2025 Data Designer - When reviewing rules and sliding the Message/Where column separator to the left to see
large WHERE definitions, the column incorrectly resets back to the prior location when switching to
another R:BASE tab (R> Prompt, Editor, etc.) and back to the Data Designer.

103. 09/18/2025 Database Explorer - Exceptions can occur when creating, deleting, and recreating a database using a
command file at the R> Prompt.

104. 09/18/2025 Data Browser - A minimized state can be incorrectly persisted after reopening the Data Browser, which
appears as though R:BASE is not responding, when in fact it is showing a modal form that is minimized.
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11.0.3.11120Release Build:
 

105. 09/18/2025 Data Browser - The modal Data Browser minimize behavior has been updated, where instead of
minimizing the modal form, the entire application is minimized instead.

106. 09/17/2025 Commands - When unloading a table with a column which is defined with a default value containing an
apostrophe, the UNLOAD output does not allow for the table to be recreated.

107. 09/17/2025 Reports/Labels - Rich text content can appear incorrectly within Mail Merge-enabled Rich Text controls.

108. 09/12/2025 Report/Label Designer - The Grid Option check box settings are not saved when checked or unchecked
within a session, and are always checked when the designer is started.

109. 09/12/2025 Form Designer - The "View > Snap to Grid" and "View > Show Grid" menu bar settings are not saved
when toggled off within a session, and are always checked when the designer is started.

110. 09/09/2025 Reports/Labels - When a DB Barcode object defined with the Auto Size and Auto Font Size properties
checked using Code 128, the barcode does not expand as expected.

111. 09/08/2025 Forms - The Enhanced DB Grid drop-down filter logic has been updated where the drop-down items are
now updated to contain only valid values relative to the existing filters.

112. 09/08/2025 Commands - When processing a dotted VARCHAR variable in a WHILE loop, the variable value is
incorrect.
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